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1. Ievads  

Paldies, ka izvēlējā�es ProtaDetails - revolucionāru automa�zētu detalizācijas, rasējumu pārvaldības un 

strukturālo komponentu projektēšanas programmu, kas ļauj:  

➢ Izveidot automa�zētus detalizētus un vispārīgus izvietojuma rasējumus no ProtaStructure modeļiem 

➢ Saražot daudzuma pacelšanās un pas�prināšanas grafikus 

➢ Lokšņu pārvaldība, izmantojot vairākus failus 

➢ Ātri izveidot un modificēt strukturālās detaļas, izmantojot inteliģentus objektus un veidnes  

➢ Izpildīt komponentu vai detaļu rasējumu piemēram, Retaining wall, Pile cap, Stair u�.     

➢ Iziet uz nozares standarta CAD formātu jaunākajām versijām DWG un DXF  

Šīs darba sākšanas rokasgrāmatas mērķis ir ātri sākt darbu. Galvenā uzmanība �ks pievērsta automa�zētu  

elementu un plānu rasējumu izveidei. Apmēram pusstundas laikā jums vajadzētu būt iespējai iemācī�es 

ProtaDetails pama�pašības.  
 

2. ProtaStructure projekta atvēršana 

ProtaStructure ātrās darba uzsākšanas rokasgrāmatā mēs esam analizējuši un izstrādājuši vienkāršu modeli. 

To pašu modeli mēs atvērsim ProtaDetails, lai izgatavotu visas detaļas un vispārīgos izvietojuma rasējumus. 

➢ Programmā ProtaStructure pārliecinie�es, vai ir atvērts Quick Start Model.  

➢ Ejiet uz Drawings & Reports →  Klikšķiniet ProtaDetails  

ProtaDetails �ks palaists kā atsevišķa programma. Jūs varat aizvērt ProtaStructure. 

Alterna�vi, jūs varat palaist ProtaDetails �eši no darbvirsmas.  

➢ Palaidiet ProtaDetails 2021 darbvirsmā.    

Parādīsies lodziņš Open Project (tas ir iden�sks ProtaStructure atvērtajam projekta lodziņam).     

  

➢ Zem projekta datu mapes atlasiet

Choose / Create Folder 

➢ Atlasiet to pašu datu mapi, kur saglabājat

modeli “Quick_Start_Model…”

 

➢ Atlasiet projektu un noklikšķiniet OK 

 

ProtaDetails darba uzsākšanas rokasgrāmata
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Ja vēla�es atvērt pabeigta modeļa paraugu, kā datu mapi izvēlie�es noklusējuma mapi ProtaData2021  
un atveriet “Quick_Start_Guide_Concrete_Complete”.  

3. Lietotāja saskarne 

TGalvenās ProtaDetails lietotāja saskarnes sastāvdaļas un rīkjoslas ir redzamas zemāk.       
 

 

 

 
 

Īsinājumtaus�ņu rīkjoslas �ek automā�ski izkārtotas atbilstoši jūsu ekrāna izmēram un izšķirtspējai.     

•  Visas komandas var izpildīt no galvenās nolaižamās izvēlnes. 

•  Īsinājumtaus�ņu rīkjoslas var mainīt, vienkārši noklikšķinot, velkot un pies�prinot gala pozīcijā.-  

•  Ar peles labo pogu noklikšķinot uz jebkuras komandas, �ek parādīta rīkjoslu izvēle (jūs varat ieslēgt / izslēgt).  

•  Jūs varat ieraks�t komandu �eši komandu lodziņā apakšā. Komandu saīsnes var iesta�t, izmantojot

Se�ngs → Op�ons → Command Aliases  

 

Kad �ek atvērts jauns projekts, �ks parādīts sākuma ekrāns ar šādām opcijām:     

•  Auto Generate Details (Detail Drawing Manager)  - 

automā�ska visu dzelzsbetona elementu armatūras detaļu un vispārējo izvietojuma rasējumu ģenerēšana.  

•  Start By Crea�ng a New Drawing -  Atveriet jaunu tukšu zīmējumu ar faila nosaukumu Drawing1.dwg). 

•  Open Project Drawing from list – Atvērt iepriekš ģenerētos un saglabātos projekta rasējumus.   

  

Details & Drawings 

& Macros  Sākuma ekrāns / 

Rasējuma skats 

Komandrinda  

Galvenā nolaižamā izvēlne 

 

Horizontālās rīkjoslas 

Ver�kālās rīkjoslas 

Ar peles labo pogu

noklikšķiniet uz 

jebkuras ikonas, lai  

Ikonas (ieslēgt / izslēgt) 
Unit & Scale Object Snap 

ProtaDetails darba uzsākšanas rokasgrāmata
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Details tab 

Drawings tab 

Macro tab 

  

Cilnē Details tab ir uzskai�ta un sakārtota visa iespējamā struktūras  

informācija, piem., Form Plans (layout), ko var izveidot. 

Noklikšķinot uz trīsstūra pirms teksta, saraksts �ks paplašināts, lai parādītu 

sīkāku informāciju.  

✓ Atzīme nozīmē, ka rasejumā ir ievietota konkrēta detaļa.

 

Zaļās krāsas elementu marķējumi nozīmē, ka elements ir veiksmīgi 

   

Tas ļauj jums viegli izsekot un efek�vi pārvaldīt detaļas.

 

Cilnes Drawings tab sarakstā �ek sakārto� visi izveido�e rasējumu (dwg)    

faili un kāda informācija ir rasējumos.  

Kad būs izveidots rasējums un ievietota informācija, tas �ks pievienots sarakstā.

Noklikšķinot uz trīsstūra pirms galvenās mapes, �ks parādīta sīkāka informācija.
 

Tas ļauj ēr� sekot un efek�vi pārvaldīt rasējumus.

 

Ja ar peles labo pogu noklikšķiniet uz zīmējuma detaļas, ir iespēja “Goto Detail”, 

kas atrod šo detaļu un tuvina to.  

 

 
Cilnē Macro tab ir uzskai�� izmanto�e un izveido�e   

inženiertehniskā dizaina macro. 

Ja ar peles labo pogu noklikšķiniet uz macro, ir papildu iespējas �eši rediģēt, 

dzēst, iet uz detaļām un atvērt rasējumus.     

 

ProtaDetails darba uzsākšanas rokasgrāmata
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Se�ng tab 

Pirms jebkādu detaļu izveidošanas ieteicams pārska�t iesta�jumus (Se�ngs), piemēram, Layers, jo tas �eši   

ietekmē galīgo izvadi.   

Visi slāņi, materiāli, elementu iesta�jumi �ek �eši manto� no modeļa, kas veidots ProtaStructure. 

        

Se�ngs → Op�ons satur daudzus citus iesta�jumus, piemēram, Display.    

  

Noklikšķiniet uz trīsstūra, lai parādītu citas iespējas. Noklikšķiniet uz Scales, lai pārbaudītu noklusējuma Scales.  

  

Pirms detaļu izveides varat mainīt jebkuru no iesta�jumiem. Iesta�jumi, kas saglabā� ProtaDetails, automā�ski  

 �ks lieto� vienam un tam pašam ProtaStructure projektam (jo abiem ir vienādi un �e paši projekta faili).    

ProtaDetails darba uzsākšanas rokasgrāmata
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4. Modeļa detalizācijas rasējums 

Ātrākais veids, kā vienā reizē izveidot visu informāciju, ir izmantot sākuma ekrāna (Start Screen) funkciju 

Auto Generate Details. 

➢ Vai arī dodie�es uz ProtaStructure (augšējā izvēlne) → Details Drawings Manager   

 

Parādīsies dialoglodziņš, kurā būs iekļautas vai izslēgtas dažādas detaļas.

Katrai detaļai ir papildu iespēja, kad tā �ek atlasīta. 

   

➢ Izvēlie�es informāciju, kuru vēla�es ražot, pārbaudot dažādas opcijas.   

➢ Noņemiet atzīmi no rū�ņas Draw On Separate Files (lai visi da� �ek ievieto� vienā failā).    

➢ Noklikšķiniet uz Draw un �ks izveidota visa informācija, ieskaitot plāna rasējumus.    

 

➢ Close rasējuma failu, noklikšķinot uz rasējuma x ikonas.    

➢ Kad �ek piedāvāts saglabāt, izvēlie�es NO. 

ProtaDetails darba uzsākšanas rokasgrāmata
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Lai gan šī metode ir ātrākais veids, kā ievietot visas detaļas, reālā projektā var nebūt piemērota visu detaļu  

ievietošana vienā rasējumā. Turpmākajās sadaļās mēs ievietosim dažādas detaļas dažādos rasējumu failos, lai 

parādītu, kā detaļas un rasējumus var sistemā�ski pārvaldīt.  

5. Plāna / izkārtojuma izveide  

Tagad mēs izveidosim projekta plāna detaļas un ievietosim to jaunā rasējumā.  
 

➢ Dodie�es uz File → New Drawing, lai sāktu jaunu zīmējumu   

➢ Veiciet dubultklikšķi uz Detail Drawing Manager cilnes Details tab    

        

 

 

 

 

 

 

 

 

 

 

Tiks parādīts dialoglodziņš, kurā būs redzamas opcijas, kā parādīt slab reinforcement bars, member dimensions

& hatching columns. Pamatu plāns, kurā showing ra�, foo�ng & pile caps (ja tādi ir), �ks parādīts St: 0.  
 

➢ Pārliecinie�es, vai ir atlasī� visi Storeys & Form Plan.   

Varat atlasīt vairākas reizes vai noņemt atlasi, nepārtrauk� turot nospiestu taus�ņu CTRL un kreiso klikšķi.  

➢ Atveriet cilni Op�ons 2 & 3 un pārska�et visus papildu iesta�jumus → Draw    

➢ Noklikšķiniet jebkur rasējumā, lai ievietotu detalizētu informāciju par plāniem. 

  

➢ Dodie�es uz File (augšējā galvenā izvēlne) → Save Drawing As        

ProtaDetails darba uzsākšanas rokasgrāmata
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➢ Mainiet faila nosaukumu uz “Plan Layout” un pēc tam noklikšķiniet uz OK    

❖ Varat arī ātri izveidot �kai Form Plans:     

 

 

 

 

 

Informācijai, ja vēla�es ievietot konkrēta stāva plāna detaļas:  

 

  

Padoms: zaļā atzīme blakus Storey norāda, ka detaļa ir ievietota rasējumā. 

2 nos. zaļo atzīmju norāda, ka detaļa ir ievietota divas reizes. 

6. RC slab šķērsgriezumi ar armatūras detaļām  

Ar pas�prinājuma detaļām var izveidot pas�prinātu plātnes šķērsgriezumu. 

Programmā ProtaDetails sagrieziet sadaļas jebkurā izkārtojuma rasējumā un novietojiet to jebkurā vietā rasējumā. 

❖ Pirmkārt, slab s�prinājumi jāparāda plāna izkārtojumā. Ja nē, tad pārliecinie�es, ka:  

➢ Programmā ProtaStructure pārliecinie�es, vai visi slab s�prinājumi ir projektē�, izmantojot slab strips. 

➢ Atveriet cilni Drawings & Reports → Palaist ProtaDetails     

➢ Programmā ProtaDetails ģenerējiet Form Plan, pārliecino�es, vai ir parādītas opcijas Show Rebars.  

  

Padoms: Citas opcijas Slab ir pieejamas cilnē Opcijas 2.   

➢ Izvērsiet Forms Plans, noklikšķinot uz trīsstūra ikonas  
 

 
➢ Noklikšķiniet uz St: 1, lai to atlasītu → Ar peles labo pogu    

 

 

➢ Noklikšķiniet uz kādas vietas rasējumā, lai to ievietotu. 

➢ Atlasiet Form Plans  
 

➢ Ar peles labo pogu noklikšķiniet → Draw Form Plans 

 

 

ProtaDetails darba uzsākšanas rokasgrāmata
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➢ Atveriet sadaļu Detail Library (augšējā izvēlne) → Pick Plan Sec�ons    

➢ Alterna�vi, apakšējā Command rindā ieraks�et “FormSec�on”   

➢ Lodziņā Sec�on ievadiet / atlasiet vēlamās opcijas.    

➢ Zīmējiet līnijas “sec�on cut” līniju, plāna skatā noklikšķinot uz 2 punk�em. 

 

➢ Noklikšķiniet uz vēlamās vietas, lai ievietotu sadaļas detaļas. 

Padoms:  Noklikšķiniet uz ikonas                 apakšā, lai pārliecinātos, ka līnija ir �eši horizontāla / ver�kāla.   

 

7. Kolonnu un sienu izklājumu izveide  

Tagad mēs izgatavosim kolonnu / sienu grafikus jaunā rasējumā.   

➢ Dodie�es uz File (augšējā galvenā izvēlne) → New Drawing, lai sāktu jaunu rasējumu.   

➢ Veiciet dubultklikšķi uz Detail Drawing Manager cilnes Details tab augšdaļā  

  

 

➢ Pārbaudiet Shearwalls, lai iekļautu arī bīdes sienas.   

➢ Atveriet cilni Op�ons.Atveriet cilni O     

Izvēlie�es Column Schedule → Filter tab ļauj  

izvēlē�es, kuras kolonnas / sienas iekļaut.  

Pēc noklusējuma �ek atlasītas visas visu stāvu kolonnas. 

Ja vēla�es atkārto� izvēlē�es kolonnas / sienas, vienkārši

turiet nospiestu taus�ņu CTRL un pēc tam izvēlie�es 

atsevišķas kolonnas un sienas.  

Varat arī turēt nospiestu taus�ņu SHIFT → Izvēlie�es pirmo 

elementu → Izvēlie�es pēdējo elementu → �ks atlasī� arī visi  

starp �em esošie elemen�.  

 

Sec�on A- A 

A A 

ProtaDetails darba uzsākšanas rokasgrāmata
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➢ Noklikšķiniet uz Draw un noklikšķiniet uz zīmējuma atrašanās vietas, lai to ievietotu (kā parādīts zemāk).    

 

 

 

  

❖ Alterna�vs kolonnu grafika ievietošanas veids:  

➢ Cilnē Details (kreisajā rū�) ar peles labo pogu  

noklikšķiniet uz Column Eleva�on Drawings →     

Parādīsies tas pats Column Schedules dialoglodziņš.

 

Cilnē Opcijas ir vairāk iesta�jumu, kas kontrolē zīmējuma izvadi

un prezentāciju. Jaunākās iespējas ir paskaidrotas zemāk: 

❖ Group Similar Columns - kolonnas ar vienādu sekcijas lielumu

un armatūru �ks grupētas kopā.  

❖ Draw Bo�om Sec�on for Slanting Column -  Pievieno papildu

apakšējās daļas griezumu slīpajai kolonnai.  

❖ Draw Outline of Change in Column Size – ja kolonnas lielums

mainās starp stāviem, �ks uzzīmēta arī apakšējā kolonna.

 

 

 

 

ProtaDetails darba uzsākšanas rokasgrāmata
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8. Column Eleva�on Details veidošana  

Tagad tajā pašā zīmējumā ievietosim kolonnas augstuma detaļas.  

➢ Veiciet dubultklikšķi uz Detail Drawing Manager cilnes Detail tab augšdaļā.   

 

➢ Alterna�vi, ar peles labo pogu noklikšķiniet uz Column Eleva�on Drawings → Draw Column Eleva�ons       

➢ Dialoglodziņā Column Eleva�on atzīmējiet �kai Column Eleva�on   

➢ Atveriet cilni Op�ons, lai pārska�tu citus iesta�jumus → Draw    

➢ Noklikšķiniet uz vietas zīmējumā, lai ievietotu detaļu. 

Tiks izveidotas visas kolonnu un sienas augstuma detaļas, kā arī daudzuma tabula, kā parādīts zemāk. 

 

Tagad mēs ievietosim kombinēto kolonnas augstumu, kas aptver vairākus stāvus. 

➢ Izvērst Column Eleva�on Drawings  

➢ Izvērst ST: 1  → Atlasiet 1C1 or GC1 

ProtaDetails darba uzsākšanas rokasgrāmata
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➢ Ar peles labo pogu noklikšķiniet → Draw Column Eleva�on (Through Storeys)   

     

Ņemiet vērā, ka izvēlnē ir pieejamas atsevišķas kolonnu augstuma opcijas.  

➢ Dialoglodziņā Select Storey pārliecinie�es, vai ir atlasī� visi veikali → OK   

➢ Noklikšķiniet uz vietas rasējumā, kur ievietot detaļu  

➢ Izvērsiet Shearwall Eleva�on Drawings  

➢ IzvērsietST: 1 → Atlasiet 1W1 vau GW1 

➢ Atkārtojiet tās pašas darbības, lai ievietotu sienas detaļas (kā parādīts zemāk).   

 

➢ Dodie�es uz File (augšējā galvenā izvēlne) → Save Drawing   

➢ Mainiet File Name uz Column Schedule & Eleva�on un pēc tam noklikšķiniet uz OK     

ProtaDetails darba uzsākšanas rokasgrāmata
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9. Kolonnu plānu izveide  

Kolonnu plāns parāda kolonnu s�prinājumu plāna izkārtojuma skatā.

Kolonnas būs jāzīmē lielākā mērogā nekā plāna skats, lai skaidri parādītu s�prinajumu.  

➢ Dodie�es uz File → New Drawing, lai sāktu jaunu rasējumu.     

➢ Veiciet dubultklikšķi uz Detail Drawing Manager cilnes Details augšdaļā.     

➢ Alterna�vi, ar peles labo pogu noklikšķiniet uz Column Applica�on Plans  → Draw Column Applica�ons 

 

➢ Pārliecinie�es, vai ir atlasī� visi stāvi → Izvēlē�es Draw → Noklikšķiniet uz vietas, kur ievietot detaļu      

Tālāk parādīts kolonnu lietojuma plāna piemērs.  

 

ProtaDetails darba uzsākšanas rokasgrāmata
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➢ Dodie�es uz File (augšējā galvenā izvēlne) → Save Drawing     

➢ Mainiet File Name uz “Column Applica�on Plan” un pēc tam noklikšķiniet uz OK     

Informācijai, ja vēla�es ievietot kolonnas piemērošanas plānu konkrētam stāvam:  

 

 

 

10. Sijas detaļu izveide  

Tagad mēs ievietosim sijas detaļas jaunā rasējumā.  

➢ Go to File (top main menu) → New Drawing to start a new drawing 

 

 

➢ Atzīmējiet opciju, lai ievietotu Insert Quan�ty Table  

➢ Atzīmējiet Insert to Sheet → Izvēlē�es Sheet → Sheet List izvēlie�es A0_Prota.dxf    

❖ Vietnē varat saglabāt savu lapu C:\Users\[User]\Documents\ProtaLib\Sheets.  

Pēc noklusējuma sijas detaļas, kas ir platākas par lapu, �ks automā�ski saīsinātas no lapas apmales. 

➢ Ejiet uz Op�ons  

➢ Izvērsiet Column Applica�on Plans 

➢ Izvēlie�es konkrētu Storey 

➢ Ar peles labo pogu noklikšķiniet uz stāvu → Draw  

 

➢ Dodie�es uz File (augšējā galvenā izvēlne) → izvēlie�es

Eleva�on Drawings  

➢ Izvēlē�es Draw All Beam Eleva�ons (all Axes) 

 

ProtaDetails darba uzsākšanas rokasgrāmata
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➢ Izvēlie�es, kā saīsināt zem Beam Axes Wider Than Sheet, atlasot nolaižamajā sarakstā:   

•  Nenogrieziet, pat ja siju detaļas atrodas ārpus loksnes apmales  

•  Saīsiniet no lapas robežas   

•  Truncate The Closest Axes from Sheet Border - nodrošinās saīsināšanu �kai pie asīm   

➢ Pārbaudiet iespēju ievietot betona siju izklājumu.   

➢ Noklikšķiniet uz Draw → Noklikšķiniet uz zīmējuma pozīcijas, lai ievietotu visu stara augstuma informāciju   

 

  

ProtaDetails darba uzsākšanas rokasgrāmata
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Concrete Beam Schedule parāda stara s�prinājumu tabulas formātā (kā norādīts zemāk)  

 

➢ Save rasējuma failu kā Beam Eleva�ons  

Siju detaļu ievietošana atsevišķi   

Ja vēla�es ievietot �kai noteiktu siju asi:  

➢ Izvērsiet Storey   ST:1  

 

Siju detaļu ievietošana pa vienai  

Lai par�jas režīmā ievietotu detaļas par visām konkrētā stāva asīm:  

  

Sijas �ks uzskai�tas pa dizaina un detaļu asīm; 

līdzīgi tam, kā tas �ek parādīts ProtaStructure staru konstrukcijā. 

➢ Select any of the beams, eg. 1B1-1B2… 

➢ Ar peles labo pogu noklikšķiniet → Draw  

➢ Noklikšķiniet uz pozīcijas, lai ievietotu detaļu rasējumā.  

Blakus stara asīm parādīsies zaļa atzīme, kas norāda, ka stara detaļa ir ievietota. 

 

➢ Atlasiet St:1 

➢ Ar peles labo pogu noklikšķiniet → Draw Beam Eleva�ons 

➢ Noklikšķiniet uz pozīcijas, lai rasējumā ievietotu 1. sijas detaļu 

 
➢ Turpiniet klikšķināt pēc kārtas, lai novietotu citas sijas.

 ➢ Nospiediet Esc, lai priekšlaicīgi pārtrauktu procesu.  
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11. Meklēt elementa informāciju vai tekstu 

Ir meklēšanas funkcijas, kas ātri atrod, filtrē elementu detaļas vai tekstu, piemēram, sija 1B1.  

Kā izmantot meklēšanu Treeview:  

➢ Ejiet uz Details  

➢ Lodziņā ievadiet dalībnieka marķējumu, piemēram, 1B2  

Tiks atrasta un parādīta �kai informācija ar precīzu 

nosaukuma atbils�bu. Pēc tam jūs varat uzzīmēt �kai šo detaļu. 

➢ Ar peles labo pogu noklikšķiniet → Draw  

Tas ir ļo� noderīgs, ja vēla�es uzzīmēt �kai konkrētu detaļu, nevis visas.  

Pēc detaļu vai objektu zīmēšanas rasējumā varat izmantot jauno teksta meklēšanas funkciju, lai to atrastu.  

Kā izmantot teksta meklēšanu:  

  

➢ Atveriet Edit → Search Text (CommandLine: SearchText)      

➢ Dialoglodziņā Search Text ieraks�et tekstu, piemēram, 1C11 → Enter    

➢ Veiciet dubultklikšķi uz atrastajiem vienumiem, un tas �ks atrasts un fokusēts   

 Šo funkciju var izmantot, lai meklētu visus tekstus arī primi�vās vienības un inteliģentos objektos.  

12. Rasējumi   

Cilnē Drawings �ek uzskai�tas dažādas ievietotās detaļas, kā arī izveido�e zīmēšanas faili. 

Tas ļaus jums sistemā�ski un efek�vi pārvaldīt projekta detaļas un rasējumus.  

  

➢ Noklikšķiniet uz cilnes Drawings, lai pārska�tu visus saglabātos rasējumu  
failus un informāciju par �em. 

➢ Noklikšķiniet uz trīsstūra ikonas, lai izvērstu vai sakļautu informāciju.   

➢ Pārbaudiet, vai ir ievietota visa informācija. 

Lai atrastu elementu detaļas rasējumā:  

➢ Pārliecinie�es, vai rasējums ir atvērts. 

➢ Atrodiet elementu, urbjot trīsstūri.  

➢ Ar peles labo pogu noklikšķiniet → Goto Detail  

Dalībnieka detaļas rasējumā �ks izvietotas un fokusētas.
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13. Rasēšanas vadība  

Ir funkcijas, lai uzzīmētu un atjauninātu detaļas, kas pieejamas no ProtaStructure rīkiem (augšējā izvēlne): 

 

 

Update All Model Drawings – atjaunina visus modeļa rasējumus, nepārbaudot, vai ProtaStructure modelī   
kaut kas ir mainījies. Šis ir piespiedu atjauninājums. Visi zīmē�e priekšme� ir spies� atjauno�es.   
 
Update Modified Members Only – pārbauda un sniedz visu ProtaStruture modificēto elementu kopsavilkumu.
Ja izvēla�es turpināt, atjaunināšanai �ek izmanto� �kai modificē� dalībnieki. .
 
Update All Plan Sec�ons - atjaunina visas manuāli izveidotās plāna skata sadaļas.  
 
Drawing Summary - izveido tabulu ar rasējuma failu nosaukumiem un to a�ecīgajiem detaļu komponen�em.  
 
Model Info - Ievieto tabulu, kurā parādīts projekta informācijas kopsavilkums, piemēram, materiāli un parametri. 
 
Concrete Rebar Schedule – Ievieto konkrēta stāva betona armatūras izklājumu.  
 
Column Link Details – Uzzīmē kolonnu un daudzuma tabulas saites informāciju.   
 
Column Rebar Details – Uzzīmē galvenās pas�prinājuma kolonnas detaļas un daudzumu tabulu. 
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14. Dimensiju s�lu saskarne  

Dimensiju s�lus var rediģēt, izmantojot šo saskarni, un tos var saglabāt kopā ar projektu.  

➢ To varat atrast sadaļā Formts (augšējā izvēlne)> Dimension Styles    
➢ Visi detaļu ģenerēšanai nepieciešamie izmēru s�li būs iepriekš definē�.  
➢ Izmantojiet pogas “+” un “x”, lai pievienotu / noņemtu izmēru s�lus.  
➢ Rediģējiet elementus, kā vēla�es. Noklikšķinot uz OK, �e �ks saglabā� projekta datos.

 
 

 

 

15. Vairāku tabulu atlase ziņojumu sagatavošanai  

Jebkuru tabulu, kas uzzīmēta ProtaDetails, var pārveidot par pārskatu un ģenerēt, izmantojot atskaišu pārvaldnieku. 

 Kā izmantot: 

➢ Atlasiet tabulas, turot nospiestu CTRL.  
 

➢ Ar peles labo pogu noklikšķiniet → Add to Report  

➢ Piešķiriet tai nosaukumu → OK  

➢ Pārskats �ks izveidots.  

Šis konkrētais pārskats �ks pievienots arī pārskata

pārvaldniekā (Report Manager) ProtaStructure 

(sadaļā Other Structural Members) 
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16. Inženierdizaina bibliotēkas  

Strukturālo komponentu dizains un detaļas, piemēram, Can�lever Retaining Wall, Pile Cap, Pile Design,    
Engineering U�li�es, Stairs, Corbel & Pool, ir pieejami, izmantojot Design Libraries (augšējā izvēlne).     
Šie jaudīgie inženierijas moduļi nodrošina pilnu aprēķinu ziņojumu, detalizētus rasējumus un daudzumus. 

Konsoles atbalsta siena ( )Can�lever Retaining Wall 

  

 

 

 

 

 

 

Pile cap (pāļu vāks) 

 

 

 

 

 

 

 
 

Pile Design (Pāļu rasējums) 
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Stairs Design (Kāpņu rasējums) 
 

 

 

 

 

 

 

 
 

Pool Design (baseina rasējums) 

 
 

Pēc bibliotēkas palaišanas aizveriet moduli un noklikšķiniet uz jebkuras vietas tukšajā rasējumā, 
lai ievietotu detaļu un daudzumu tabulu (ja piemērojams). Pēc tam aprēķins �ks pievienots cilnē Macro.   .

Ja ar peles labo pogu noklikšķiniet uz makro, ir papildu iespējas �eši rediģēt (Edit),  

    

Saglabājiet rasējumu, lai nodrošinātu, ka macro �ek saglabā�, kad rasējums ir aizvērts. 

 

 

Šīs inženieru bibliotēkas �ks nepārtrauk� paplašinātas, lai apmierinātu inženiertehniskās vajadzības.  
Mēs iesakām jums sniegt atsauksmes par to, ko vēla�es redzēt tālāk. 

Jūs varat turpināt vadīt inženieru bibliotēkas, kā norādīts turpmākajās sadaļās.  
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16.1 Inženiertehniskie pakalpojumi ātrai projektēšanai un aprēķiniem 

Ērto Engineering U�li�es var izmantot parocīgos inženiertehniskos pakalpojumus.   

Tas ietver kalkulatoru betona segumam, armatūras s�prinājumiem un apļa garumiem; vienkāršs stara analīzes rīks 

maksimālās bīdes aprēķināšanai, moments un novirzes; hidraulikas kalkulators vienmērīgam plūsmas dziļumam un  

Kā izmantot
 

➢ Atveriet Design Library (augšējā nolaižamā izvēlne) → Engineering U�li�es   
 

 

Šis ir pilns moduļu un to funkciju saraksts:  

1. Cover and Anchorage Calculator   
➢ Aprēķina betona segumu, s�prinājumu un malu garumus. 

2. Hook Length Calculator 
➢ Aprēķina armatūras locīšanu, pagarinājumu un kopējo āķa garumu. 

3. Rebar Area Calculator  
➢ Aprēķina paredzēto tērauda laukumu uz metru (piemēram, 10H16 @ 100mm atstatums). 

4. Unit Conversion 
➢ Pārvērš parastās inženiertehniskās mervienības.   

5. Simple Beam Analysis 
➢ Aprēķina maksimālo bīdes ātrumu, momentu un deformāciju viena laiduma sijai ar dažādiem atbalsta 

apstākļiem, piemēram, vienkāršu, konsolveida un fiksētu galu. 

6. Uniform Flow Depth (Hydraulics) 
➢ Atrisina taisnstūra, trapecveida vai apļveida kanālu novadīšanu, plūsmas dziļumu, kanāla platumu vai 

slīpumu “uniform flow depth” apstākļos.  

7. Gradually Varied Flow (Hydraulics) 
➢ Atrisina taisnstūra, trapecveida vai apļveida kanālu novadīšanu, plūsmas dziļumu, kanāla platumu vai 

slīpumu “gradually varied flow” apstākļos.  
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16.2 Pool / tank Design  

Pool Design var izmantot, lai analizētu, noformētu un detalizētu dažādu formu un izmēru baseinus vai tvertnes.

Jūs definējat dažādus augsnes profilus, kas ieskauj baseina sienas, un pievienojat augsnei pielaides.  

Kā lietot  
➢ Atveriet Design Library (augšējā nolaižamā izvēlne) → Pool Design   

Dialoglodziņā Pool Design sāciet definēt baseinu, izmantojot ikonas no kreisās puses uz labo.  
 

 

1. Atlasiet no galerijas 
➢ Atlasiet baseina veidu

2. Points : Nosaka tvertnes sienu raksturojumu un formu.  
➢ Ievadiet tvertnes apakšējo un augšējo augstumu. Atšķirīgs ir tvertnes dziļums.    
➢ Points table : Nosakiet katras plātnes apakšējās savienojuma koordinātas. Arī malu izliekumu.   

3. Slabs Nosakiet tvertnes apakšējās (-o) plāksnes (-u) raksturojumu un formu.  
➢ Points table : Nosakiet katras plātnes apakšējās locītavas koordinātas. Arī malu izliekumu.   

4. Materials & Loads : Definējiet materiālu, kodu, augsnes modeli un slodzes. 
➢ Material Projektēšanai izvēlie�es betona šķirni, armatūras pakāpi un diametru. 
➢ Se�ngs Izvēlie�es noformējuma kodu un parametru 
➢ Soil Model Izvēlie�es ak�vo vai pasīvo slodzi, ilgtermiņa vai īstermiņa slodzi, ūdens līmeni u�. 
➢ Soil Profile Definējiet augsnes profilu un slāņus 
➢ Surcharge  : Ievades papildslodzes (point, line, strip & surface load)  
➢ Results & Report Izdrukājiet un pārska�et sienu analīzes rezultātus, piemēram, spiedienu un spēku.   

5. Design Projektējiet tvertnes sienas un pamatni  
➢ Mainiet sienas un plātnes biezumu un noklikšķiniet uz Renew Rebar Design (ja pirmā dizaina kārta neizdodas)  
➢ Izvēlie�es slodzes gadījumus, piemēram, pēc būvniecības, ekspluatācijas, apkopes vai zemestrīces.  

6. Draw Details  : Zīmējiet armatūras detaļas plānā un sagrieziet sekcijas.  

7. Print Report :  Izdrukājiet visu kopas pārskatu, ieskaitot ģeometru, analīzi un dizainu.  

8. Transparency : Parāda pas�prinājumu 3D formātā. 

9. Zoom Extent Tuviniet diagrammas lielumu.  

10.  OK : Noklikšķiniet uz OK, lai izietu un ievietotu detalizēto rasējumu pašreiz atvērtajā rasējumā.  

Pt 1 

Pt 2 

Pt 3 

Pt 4 

ProtaDetails darba uzsākšanas rokasgrāmata



  
  

25 

 

17. Noslēguma kopsavilkums 

   

   
Šajā darba uzsākšanas rokasgrāmatā jūs redzējāt, cik viegli ir izveidot projekta modeļa, kuru    

vispirms uzsākāt izstrādāt programmā ProtaStructure, detaļu pas�prināšanas un izkārtojuma rasējumus.   

Jūs arī atklājāt, kā inženierkomponentu bibliotēkas ļauj efek�vi sagatavot visaptverošus analīzes un rasējuma     

 pārskatus un detalizētus armatūras rasējumus.   

 

 

ProtaDetails ir daudz spēcīgāku detalizācijas funkciju, piemēram, inteliģen� objek�.  

Lai iegūtu papildu palīdzību un norādījumus, lūdzu, ska�et palīdzības atsauci, kas pieejama izvēlnē Help.   

Varat arī apmeklēt mūsu apmācības kursus, lai iegūtu padziļinātākas zināšanas par programmatūras lietošanu.

Lūdzu, apmeklējiet mūsu vietni , lai iegūtu vairāk informācijas.www.protaso�ware.com   
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